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NOTE: There may be revised processes and documentation available.

Check the NPScape methods webpage
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Overview

NPScape is a landscape dynamics monitoring project that provides landscape-level data, tools, and
evaluations for natural resource management, planning, and interpretation (NPS 2013). This standard
operating procedure (SOP) provides guidance on how to process NPScape area density metrics used in
classifying and describing spatial characteristics such as intact vs. patchy habitat, where cover type
density is calculated based on different sizes of moving windows. NPScape offers pre-processed area
density source data for forest and grassland cover types, estimated from the National Land Cover
Dataset, NLCD (2006; 30 m resolution; Lower 48) and the North American Land Change Monitoring
System, NALC (2005; 250 m resolution; AK, Canada, Lower 48, Mexico). Additional methods presented
in the Appendices provide guidance on how to replicate these density metrics for other cover types or
sources of land cover data. Download the tool(s) and a copy of this SOP here:
http://science.nature.nps.gov/im/monitor/npscape/methods.cfm. The zip file includes an ArcGIS™ toolbox
containing NPScape pattern script tools and a copy of this SOP document.

The purpose of this SOP is threefold. First, because these directions were followed in the processing of
the NPS datasets, it provides detailed documentation on the methodology used by NPScape to calculate
area density metrics for the Pattern measure. Second, this SOP provides any user with the ability to
replicate the creation of these data for custom areas of analysis. Finally, if an I&M park or network has a
need to analyze data other than forest of grassland density from NLCD or NALC, this SOP provides a
processing template for recalculating focal metrics associated with the Pattern measure.

NPScape forest and grassland area density are calculated using a moving window analysis. First, a
square neighborhood (window) for analysis is defined by the number of pixels on each side. The
proportion of pixels in the window of a particular cover type (e.g., forest or grassland in this case) is
calculated and assigned to the pixel in the center of the window (Riitters et al. 2000, 2002; Wickham et al.
2007, 2008). Because density is computed over (typically) large windows or areas, compared to other
pattern metrics it is relatively insensitive to change (e.g., compared to a pixel-level pattern classification
such as morphological spatial pattern analysis [MSPA]).

Riitters et al. (2003) and Riitters (2005) discuss and provide a method for scaling and mapping /
interpreting clusters of pixels with similar scale-dependent characteristics. Results from the NPScape
categorization of density values can be used to identify areas where the target cover type range from
intact to rare.

B Intact

I Interior

[ Dominant

[] Transitional

[ Patchy

I Rare

NPScape pattern density metrics are intended to assist with monitoring questions related to habitat
condition. In general, the value of this metric will be greatest when used in interpretations with other
landscape metrics. See the NPScape Interpretive Guide for additional guidance (Monahan et al. 2012).

The National Land Cover Dataset (NLCD) is a high resolution raster of land cover for the continental

United States. Pattern density metrics derived from NLCD and NALC include the following rasters, where

<*> is the moving window size in pixels per edge (see Appendix 2 for thematic class details):
Pattern_<Forest/Grassland>Density _Categories_<*> <NLCD2006/NALC2005>_Focal.tif


http://science.nature.nps.gov/im/monitor/npscape/methods.cfm
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Grouped Density Class Definitions

Density Class Density Category (p)
Intact p=1.0

Interior 09=<p<1.0
Dominant 06=<p<0.9
Transitional 04<p<0.6

Patchy 0.1<sp<04

Rare 0.0<p<0.1

None p=0.0

Preprocessed source data are available for the following window sizes (in number of pixels per edge):
NLCD 7x7, 13x13, 27x27, 81x81, 243x243, and 729x729; NALC 7x7, 11x11, 15x15, 27x27, and 39x39.
See Appendix 2 for detailed area values for these window sizes.

This document summarizes the methods used to generate these outputs for any area of analysis from the
NPScape preprocessed source data. For details on how the preprocessed source data were created, see
Appendix 5.

Using an ArcGIS™ toolbox, processing steps include clipping the input density source raster to the area
of analysis (AOA), reclassifying the raster using an input reclassification table, calculating the total and
class areas (kmz), and producing table summarizing area totals and percent total area for the AOA.

Any AOA can be used as long as its spatial reference matches that of the tool input data.

This SOP may be used with other (non-NLCD2006) tool input data if source density pre-processing is
completed and specific criteria are met. For specific instructions for generating density source data from
other sources or for other indicator cover types, see the Cover Type Extraction and Indicator Raster
Creation section of Appendix 5, and Appendix 3 for additional details. The data sources were produced
and tools tested using ESRI ArcGIS™ version 10.0 Service Pack 5.

Software Requirements

ArcGIS software is required to generate the metric outputs. The data sources and tools used are
assumed to be in ESRI ArcGIS™ format, version 10 Service Pack 5 or higher.

Data Requirements

Forest and Grassland Density Rasters

Pattern_<Forest/Grassland>Density Categories_<*> NLCD2006_Focal.tif
Pattern_<Forest/Grassland>Density Categories_<*>_ NALC2005_Focal.tif
Download path: http://science.nature.nps.gov/im/monitor/npscape/qgis data.cfm

Note: tools can be run using NALC-derived pattern inputs instead of NLCD-derived data. NALC covers
North America to the Mexico border and is available from the link above.

If you are a NPS user, you can contact the NPScape team to request a custom clipped extent:
mailto:NRSS NRPC NPScape@nps.gov

See the Frequently Asked Questions section for other data access options.


http://science.nature.nps.gov/im/monitor/npscape/gis_data.cfm
mailto:NRSS_NRPC_NPScape@nps.gov
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Area of Analysis polygon

AOA polygons for boundaries and 3 km and 30 km buffers of parks, CEC ecoregions, FWS LCC
polygons, and upstream watersheds (for selected parks) are available as NPScape datasets:
http://science.nature.nps.gov/im/monitor/npscape/methods.cfm

Alternatively, user-defined AOA polygons can be used if they conform to the input spatial reference.

Reclassification Tables:
NPScape uses reclassification (recode) tables to thematically group density pattern data into grouped

density classes. See Appendix 2 for details. These tables are bundled with the NPScape Pattern Metrics
tools zip file in the ToolData folder.

Input data spatial reference

For CONUS areas, the NPScape project uses USA Contiguous Albers Equal Area Conic USGS as its
standard spatial reference. A local (i.e. custom, non-NPScape sourced) area of analysis polygon may be
used if its spatial reference matches the NPScape-provided tool input raster or vector data. In this
scenario, re-project your local AOA data (if necessary) and run repair geometry on it before running the
tool(s). See the Frequently Asked Questions section for more details on re-projecting tool outputs or tool
inputs.

Input Data Pre-Processing

Determine AOA polygon

If using an NPScape-sourced AOA, download the appropriate AOA geodatabase from the link in the Data
Requirements section.

Re-project user-defined input datasets (if needed)

All user-defined, custom, non-NPScape sourced tool inputs (e.g. AOA polygon) must be in the USA
Contiguous Albers Equal Area Conic USGS spatial reference if used with NPScape-sourced tool inputs.

1. Open ArcCatalog or ArcMap. Click the search button and search for ‘Project’. Open the
Project tool and re-project your data to USA Contiguous Albers Equal Area Conic USGS.

2. Search for ‘Repair Geometry’ and run that tool on your re-projected dataset.

3. See the Frequently Asked Questions section for more details.

Download tool input dataset(s)
Download the forest and/or grassland Density tool input dataset (for desired edge width) from the link in

the Data Requirements section. These datasets are seamless across the maximum available extent of
the source data.

Run PatternDensity_Metric tool

This tool generates a file geodatabase containing Land Cover-derived density raster datasets and
summary tables. These outputs correspond to the NPScape pattern density metric.

Example tool outputs (maps and tables with GDB diagram):
= |8 NLCD_Density
= B forest_density_7_test
= [ forest_density_7_test_grouped
forest_density_7_test_grouped_stats
forest_density_7_test_stats


http://science.nature.nps.gov/im/monitor/npscape/methods.cfm
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Ungrouped and grouped forest density classes for window size 7 at Theodore Roosevelt National Park

Add toolbox to ArcMap

1. Check Geoprocessing Options settings: Geoprocessing = Geoprocessing Options = ‘Overwrite
the Outputs of Geoprocessing Operations’ should be checked. This addresses an issue in
ArcGIS 10.1 Service Pack 1 when using feature layers.

2. Extract the tools zip file downloaded from the methods link in the Overview section above. The
following folder structure will be created:

£ ProcessedData

£ Scripts

£ ToolData

@. MPScape_PatternTools

ProcessedData contains ArcMap layer files and is the default tool output folder. Scripts contains
the Python code used by the NPScape_PatternTools.tbx toolbox.
3. Open ArcMap use the Catalog window to navigate to the folder where the tools were extracted.
Open the NPScape_PatternTools toolbox.
4. Double-click on the PatternDensity_Metric tool to open it.
= @ MP5cape PatternTools
&' PatternDensity_Metric
Z! PatternMorphology_Metric

Run the PatternDensity_Metric Tool

1. Add input data to the map:
- Tool input data: forest or grassland density GeoTIFF for desired window size
- Polygon feature class for AOA (singlepart or multipart)

2. Populate values for each of the required parameters in the tool:
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-

& PatternDensity_Metric

Source Density Raster - PatternDensity_Metric

| Pattern_ForestDensity_Categories_7_NLCD2006_Focal tif ﬂ E;- I

Area of Analysis Polygon - This tool generates a file geodatabase containing

[THRO_AOA_Park_Multi_10km ~| |§—>| pattern density raster datagets and summary

AOA Field tables. These pattern density outputs correspond

e to the NPScape PDEN metric. including two
test - .

(e e pattern rasters and statistics tables. The source
123 oF Analysls Tame were processed into six GeoTIFFs raster datasets
THR_O using different moving window sizes

Deushyieda it — (7.13.27.81,243,729). These pre-processed density
G:\NPScapeTools\Tools_Models\MPScape_Tools_Fall2012\Pattern_Tools{Tooll E;- source raster datasets include pattern density

Density Lookup Table e category or class names. This script uses these
G:\NPScapelTools\Tools_Models\NPScape_Tools_Fall2012\Pattern_Tools\Tooll |24 pre-processed source raster datasets which may

Pattern Metadata File (optional) be downloaded the NPScape website. See the

2 = Pattern Metrics SOP document for details. It is
= available from the NPScape website:

Output Folder - http://science.nature.nps.goviim/monitor/npscape.
G:\NPScapeToals\Tools_Models\WPScape_Tools_Fall20 12\Pattern_Tools'Proce |§"| System Requirements: ArcGIS 10.0 Senice Pack

Qutput Geodatabase Name 5, Pythan 2.6 or above.

MLCD_Density.gdb

Qutput Name
forest_density

Window Size
7 - d d

0K | | Cancel | |F_nvironments... | | << Hide Help | | Tool Help

Source Density Raster: full path to the preprocessed NPScape density source raster
(varies by focal cover type and window size setting)

Area of Analysis Polygon: location and name of the AOA polygon feature class

AOA Field: Text format attribute from Area of Analysis polygon. Used to label output
rasters and tables for multi-feature AOAs. If AOA polygon is a single feature, only
one output raster and output table will be generated.

AOA Name: name of the area of analysis (60 character limit)

Density Reclass Table: full path to the pattern reclassification table; located in
Pattern_Tools\ToolData

Pattern Metadata File (optional): full path to the pattern metadata XML file

Output Folder: full path location of output folder; defaults to
Pattern_Tools\ProcessedData; you must have write permission to this folder

Output Geodatabase Name: the output file geodatabase (must end with .gdb)

Output Name: Prefix for output raster and table names.

Window Size: moving window size of source input raster; added to output names as a
suffix

3. Depending on the extent of the AOA feature class, the tool may take several minutes to run.
Processing status will display in ArcMap, either as a popup or as a message in the geoprocessing
background bar. The full tool summary is found in the ArcMap - Geoprocessing - Results
popup, including error messages.

4. The clipped density raster, the grouped density raster, and the ungrouped and grouped AOA
statistics statistics tables will be added automatically to the map. If single-part AOA polygons
were used, only the rasters and statistics tables for the last feature will be added to the map.
Other output rasters and tables can be added manually and symbolized as grouped density
classes with *.lyr files in the ProcessedData subfolder.
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See tables in the Interpretation Tips section for a description of attributes in the output rasters and
statistics tables.
Running the tool again: open Geoprocessing > Results. Double-click on the
PatternDensity _Metric tool name to open the tool dialog. Change parameters as needed.
Change the output geodatabase name if you don’t want your original output over-written.

Quality Control

Verify d
1.

Verify s
1.

2.

ataset outputs

Verify the expected rasters are created and that the AOA_NAME, CLASSNAME,
TOTAL_AOA_AREA_SQKM, AOA_FEATURE_AREA_SQKM, TAREA_SQKM, AREA_SQKM,
and PCT_AREA fields are present in AOA statistics table. If a multi-feature singlepart AOA
polygon was used, there will be rasters and statistics tables for each AOA feature, named with
the value of the AOA Field attribute. However, only outputs for the last feature processed will be
added to the map automatically.

Verify that raster edges align correctly with each other and with the source raster. Use the Effects
- Swipe tool to help verify this. Note that the NPScape layer files for pattern density
(ProcessedData\*.lyr) are used to standardize the raster symbology.

If outputs were generated for multiple window sizes (by re-running the tool), add those rasters to
the map and zoom into an area and visually compare the outputs of the 7 cell window width raster
with the other cell window width rasters. Check for alignment by swiping the top raster across the
other rasters: the edges should. Note, rasters derived from grassland source rasters may not be
contiguous for all areas of interest.

Look for areas of NODATA cells within the AOA. These cells are not included in statistics
summaries, so care should be taken when interpreting outputs with NODATA areas.

tatistics output

Open each value attribute table and sort the PCT_AREA column in descending order. Look for
outlying values (negative values, more than one value near 100, sum of values > 100).
By default, only the statistics table for the last feature is added to the map. Add the remaining
statistics tables, if present, and sort each PCT_AREA column in descending order. Look for
outlying values (negative values, more than one value near 100, sum of values > 100).
Select one record from each statistics table and double-check the PCT_AREA column values by
re-calculating them by hand:

PCT_AREA = (AREA_SQKM / TAREA_SQKM) * 100

Interpretation Tips

Output raster and statistics table attributes:

Output density raster attributes:

VALUE pattern class identifier

COUNT number of cells in each pattern class

WINDOW _SIZE Number of pixels on one edge; calculated from Window Size input parameter
CLASSNAME Name of pattern class

AOA_ Name AOA name from AOA Identifier tool parameter concatenated with AOA Field value
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Statistics table attributes:

CLASSNAME Name of pattern class

WINDOW _SIZE Number of pixels on one edge; calculated from Window Size
input parameter

TOTAL _AOA AREA SQKM Total area of the AOA in km?, calculated from raster cells

AOA FEATURE_AREA_SQKM | Total area of the AOA in km?, calculated from polygon feature

TAREA_SQKM Total class area in km?, calculated from raster cells; (COUNT *
cell size®) / 1000000

AREA SQKM Class area in km?, calculated from raster cells

PCT_AREA Percent area of class, (AREA_SQKM/TAREA_SQKM) * 100

AOA_NAME AOA name from AOA Identifier tool parameter concatenated with

AOA Field value

Due to raster cell overlap outside the AOA polygon, the raster-derived total area value will be usually
slightly larger than the polygon derived total area. In coastal or shoreline areas, the total AOA area
values will be larger than the sum of TAREA _SQKM because source tool input rasters may have areas of
NODATA values that begin a few kilometers off shore.

Frequently Asked Questions

Can/should | use a different spatial reference?

Any NPScape spatial output can be re-projected to a final’ local spatial reference. For vector outputs,
Repair Geometry should be run after re-projection. This approach should be noted in explanatory or
interpretive documentation to avoid misleading the user; re-projection of an output dataset will have no
effect on area attributes in the summary table generated by the NPScape script.

All NPScape tools generate area calculations from input data. If tool input data must be re-projected prior
to running the tools, care should be taken to use a local spatial reference that distorts area minimally,
such as an equal-area projection. For CONUS tool input datasets, NPScape uses USA Contiguous
Albers Equal Area Conic USGS (NAD_83) as the spatial reference. Alaska-specific tool input datasets
are in Alaska Albers Equal Area Conic (NAD_83) while Hawaii-specific datasets use UTM Zone 5N
(NAD_83). UTM WGSB84 Zone 55N is used for Saipan and Guam while UTN NAD83 Zone 2S is used for
American Samoa.

Re-projecting vector input data:

NPScape tool input vector data can be re-projected prior to use as a tool input. The source dataset
should be clipped to an extent larger than the intended area of analysis. Then, after clipping, Repair
Geometry must be run to correct geometric errors. Finally, the clipped input can be re-projected to the
local spatial reference, followed again with a Repair Geometry operation.

Re-projecting raster input data:

Re-projection to match a local spatial reference is not recommended for raster format NPScape tool input
datasets. If re-projection is done, the source tool input raster should be clipped to an area of analysis
rectangular extent first. Then, the Processing Extent > Snap Raster environment setting in ArcGIS
should be populated with the source input tool raster. Warping will occur but should be less than it would
be without the Snap Raster setting.

Alternatively, the AOA extent could be re-projected to the same spatial reference as the NPScape input
raster followed by a repair geometry operation. Then, this polygon could be rasterized to a temporary
raster dataset with a cell size matching the input raster, setting the snap raster to the input raster to
minimize warping. Then, this temporary raster could be used to extract an area from the NPScape tool
input raster. Finally, this extracted raster could be re-projected to the desired local spatial reference as
described above.
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I’'m having trouble downloading the tool input dataset. Is there another way to get it?

Many tool input datasets are very large. Please contact the NPScape team to request a custom delivery
and/or a custom clipped extent: mailto:NRSS NRPC NPScape@nps.gov

My outputs don’t show up in my map. What can | do?

The tools use ArcGIS display layers to visualize the metric outputs. If you see ared ! by the layer name
in the map, the layer can'’t find the feature class or raster to which it is linked. The most common reason
is that the Output Geodatabase Name parameter differed from what the tool script expected. Fix the
problem by clicking the red ! and navigating to the output geodatabase. Then, select the correct feature
class or raster.

If a multi-feature singlepart AOA polygon was used, there will be an output raster or feature class and
statistics table for each AOA feature, named with the value of the AOA Field attribute. However, only
outputs for the last feature processed will be added to the map automatically. Add the remaining output
rasters/feature classes and statistics tables. Use the *.lyr files in the ProcessedData subfolder to
symbolize the features.
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Appendices

Appendix 1: Known issues

Data availability
Source NLCD and NALC-derived density tool input data are not available for off-shore parks (e.g. Dry

Tortugas), Puerto Rico, the Virgin Islands, Hawaii, or the outlying Pacific Islands. Grassland source
rasters may not be contiguous for all areas of interest

Data extent

Source NLCD-derived or NALC-derived raster data extend a few kilometers off the coasts and lakeshores
of North America. Therefore, coastal AOAs may not include seamless coverage of the source data. In
these areas, the AOA_FEATURE_AREA_SQKM attribute may be greater than the TAREA_SQKM value.

11



Pattern Measure — Area Density Metrics

Appendix 2: Lookup and reclassification tables

Date: January 6, 2014

Comparative Landscape Sizes for Pattern Density Analyses

(shaded rows indicate NLCD-derived outputs)

Window Size
(pixels per edge)

5
7
9
11
13
15
21
27
33
39
45
51
57
69
81
243
729

NLCD

Pixel Size (m) Area (hA)

30
30
30
30
30
30
30
30
30
30
30

30
30
30

2.25
4.41
7.29
10.89
15.21
20.25
39.69
65.61
98.01
136.89
182.25
N/A

N/A

N/A
590.49
5314.41
47829.69

Area (acres)
5.56

10.90
18.01
26.91
37.58
50.04
98.08
162.13
242.19
338.26
450.35
N/A

N/A

N/A
1459.13
13132.19
118189.74

12

NALC

Pixel Size (m)
250
250
250
250
250
250
250
250
250
250
250
250
250
250
250
250
250

Area (hA)
156.25
306.25
506.25
756.25
1056.25
1406.25
2756.25
4556.25
6806.25
9506.25
12656.25
16256.25
20306.25
29756.25
41006.25
369056.25

Area (acres)
386.10
756.76
1250.97
1868.73
2610.05
3474.92
6810.84
11258.74
16818.61
23490.46
31274.27
40170.07
50177.84
73529.29
101328.65
911957.85

3321506.25 8207620.67
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Density Category and Grouped Category Reclassification Table

Grouped Grouped
Byte Value Category Category Density Class Density Class
Range Value Classname Value Classname
0 0 Missing
1 1 No focal landcover | 1 None
2-12 2 >0% to <5% 2 Rare
13-25 3 5% to <10%
26 - 38 4 10% to <15% 3 Patchy
39 -50 5 15% to < 20%
51 -63 6 20% to <25%
64 - 76 7 25% to <30%
77 - 88 8 30% to <35%
89 -101 9 35% to <40%
102 - 114 10 40% to <45% 4 Transitional
115- 127 11 45% to <50%
128 - 139 12 50% to <55%
140 - 152 13 55% to <60%
153 - 165 14 60% to <65% 5 Dominant
166 - 177 15 65% to <70%
178 - 190 16 70% to <75%
191 - 203 17 75% to <80%
204 - 215 18 80% to <85%
216 - 228 19 85% to <90%
229 - 241 20 90% to <95% 6 Interior
242 - 254 21 95% to <100%
255 22 100% ’ Intact

Appendix 3: Using custom AOAs and/or local input data

Custom AOAs

The AOA feature class should include a text attribute with a name value for the AOA feature(s). This text
attribute should not contain /" or other special characters. The feature class can contain single or multi-
part polygons. If single-part polygons are used, an output raster and statistics table will be produced for
each feature, named with the attribute value selected in the AOA_Field parameter.

Local input data
Density tool input can be generated from land cover sources other than NLCD2006 and/or cover types

other than forest and grassland. Follow the Processing steps — Creating Custom Tool Input Rasters
instructions in Appendix 5 to produce custom density tool input rasters.

Appendix 4: Tool scripts
See Scripts subfolder for Python scripts used by the metric tool(s).
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Appendix 5: Tool input and metric data processing details

Source data

Information in this appendix was excerpted from details provided by Kurt Riitters (KR) on 12 June 2009
(original email edited by John Gross). In this appendix, “NLCD” always refers to the 2001 NLCD land
cover dataset. These notes are included because they also generally inform the processing and
interpretation of NLCD 2006 and NALC density metrics. For more up-to-date information, see Riitters,
2011.

Comparability with NLCD

Generally, the goal was to have a pattern value for every pixel that was not null on the NLCD map. That
was accomplished during the processing. But, when | (KR) put things together by State later on, | clipped
everything to the detailed State boundaries in the ESRI data/maps collection, using a 30-m pixelated
version of those detailed state boundaries. So you will not find pattern values for places like extraterritorial
ocean, even if those places were included in the computations of the indices.

The projections are the same as the NLCD.

Everything should be overlay-able pixel-by-pixel with the original NLCD (2001). In some instances there
may be a 1/2 pixel (or less) offset from NLCD which should not affect intersections with NLCD. There
should not be any slivers between states when you recombine the grids for several states.

The ability to intersect with the original NLCD 2001 is really important, because some of the pattern
measures will likely be summarized by original land-cover, and error will occur if the intersection of
original and ‘derived’ measures is not accurate.

For example the 'area-density' (fden and gden, for forest and grassland density, respectively) maps show
non-null pattern values for all pixels in a State, whether or not a given pixel is the focal class land cover or
not. In other words, one can have a 'forest density' context even if one is not forest oneself. The decision
to intersect or not depends on if you want to summarize forest (or grass) density in the vicinity of an
arbitrary location in a park, or only in the vicinity of the focal class in the park. The former is more
descriptive of landscapes, the latter is more descriptive of focal class patterns. | typically intersect with
focal class land cover to make inferences about focal class pattern. The maps are not intersected in this
way, to preserve options for other types of summaries, for example forest density in the vicinity of urban
pixels, etc. This same consideration also applies to the 'landscape pattern type' (aka 'mosaic') maps.

This consideration does not apply to the 'morphology' (aka 'mspa’) maps, for which the patterns are only
shown for the focal class pixels (and the non-focal class pixels are set to the MSPA class 'background’,
see Vogt 2008).

Legend / Pixel values on the "area density" maps

The values 0-22 appear on the maps/attribute tables. The table below is the translation to "Px" (forest
area density, grass area density). The ‘Recoded Class’ is the pixel ‘density class’ value in the attribute
table (0-22), and the fourth column is the definition of each density class. Min and max values are the bin
ranges.

Conversion of raw density values to classes for forest and grassland density:

Recoded
Min Val Max Val Class Definition of recoded class
0 0 0 true missing (window contains no valid land cover pixels)
1 1 1 exactly zero (window contains land cover, but none of the
focal class land cover)
2 12 2 0<Px<5
13 25 3 5<=Px<10 at least 5 but less than 10
26 38 4 10<=Px<15

14
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Recoded
Min Val Max Val Class Definition of recoded class
39 50 5 15<=Px<20
51 63 6 20<=Px<25
64 76 7 25<=Px<30
77 88 8 30<=Px<35
89 101 9 35<=Px<40
102 114 10 40<=Px<45
115 127 11 45<=Px<50
128 139 12 50<=Px<55
140 152 13 55<=Px<60
153 165 14 60<=Px<65
166 177 15 65<=Px<70
178 190 16 70<=Px<75
191 203 17 75<=Px<80
204 215 18 80<=Px<85
216 228 19 85<=Px<90
229 241 20 90<=Px<95 at least 90 but less than 95
242 254 21 95<=Px<100 at least 95 but less than 100
255 255 22 exactly 100%

The densities are first calculated as real numbers in the range from 0.0 to 1.0, and then converted to 8-bit
integers by:

MapValue = (RealValue * 254) + 1
MapValue = 0 is reserved for 'true' missing.

This conversion results in loss of precision, as does a small window (like 7x7 which only has 49 possible
values). If the window is partly missing, the calculations are based on whatever is there, and there is no
minimum number of pixels required to calculate a value for a particular window.

Processing steps — Creating Custom Tool Input Rasters

The following steps were used to process NLCD 2006 land cover into density outputs for all window sizes
(Riitters 2011). As an example, shrub land cover from the 2006 National Land Cover Dataset
(NLCD2006) is used as input to generate density rasters for shrub land using, ArcGIS v10. If other land
cover density is needed (e.qg. forest, grassland, etc), the extraction mask class(es) should be changed

appropriately.

The processing steps include generating an extraction mask for the land cover thematic class of interest
(e.g., shrub land) and extracting these pixels from the source land cover dataset. Then, the extracted
raster is reclassified to produce an indicator raster for use in density processing.

Cover Type Extraction and Indicator Raster Creation

Determine cover type of interest, extract and reclassify pixels

Determine the cover type of interest and its corresponding pixel value(s). An 8-bit, GeoTIFF format
indicator raster with two thematic classes should be produced: Value == 2 for target cover type pixels
and Value == 1 for non-target cover type pixels.
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1. Load the input land cover source raster into ArcMap. Zoom to the area of analysis. Open the
Spatial Analyst - Conditional - Con tool.

2. VERY IMPORTANT: Set Environments = Processing Extent - Extent to ‘Same as Display’ and
set Environments - Processing Extent - Snap Raster to the land cover input raster:
# Processing Extent

Extent
[Same as Display v]
Top
3090952, 764929
Left Right
-15358205,645982 -1695867,802045
Bottom
2055863.393347
Snap Raster

|nchEDUﬁ_Iandcwer_levelE ﬂ

3. Create the interim indicator raster using the Spatial Analyst - Conditional > Con tool to extract
pixels for the cover type. The Con logic finds the target pixels and generates an interim output
raster with those pixels assigned a value equal to 2. All non-target pixels are assigned a value
equal to 1. Depending on the size of the area of analysis, this operation may take several hours
to complete.

Example shrub land syntax (python):
outCon = Con((Raster (inputRaster) == 52) ,2, 1)

Example tool settings for shrub land (NLCD source):

Input conditional raster Il Con I

| nlcd2006_landcover_level2 ﬂ

Expression {optional) Performs a conditional
“value® = 52 iffelse evaluation on each

of the input cells of an
h Input true raster or constant value p

input raster.
2 =]

Input false raster or constant value (optional)

Il o K=

Output raster
i E:\WPScape\Scratch\shrubmasked?, tif

[ QK ] l Cancel ] [Envircnments... ] [ < < Hide Help ] [ Tool Help

F— — = — al

4. Run Data Management > Raster > Raster Properties - Build Raster Attribute Table with the
overwrite option selected on the interim raster.

5. If the interim raster is anything other than 8-bit unsigned, use Data Management > Raster >
Raster Dataset - CopyRaster to create the 8-bit unsigned indicator raster. Click on
Environments. Select Processing Extent - Snap Raster and set its value to the extracted raster.
Select Raster Storage - Compression and set it to ‘NONE’.

Populate the options as shown to create the 8-bit GeoTIFF indicator raster:
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Input Raster Copy Raster
I shrubmaskedd.tif
Output Raster Dataset Makes a copy of a raster

E:\NPScape'\Soratch\shrubmasked, tif dataset or loads raster
datasets into a raster

catalog.

Configuration Keyword (optional)
Ignore Background Yalue {optional)

MoData Value (optional)

[] Convert 1 bit data to 8 bit {optional)

[ Colomap to RGE {optional)

Pixel Type {optional)
8_BIT_UNSIGMED

-

QK ] [ Cancel ] [Envirnnments... ] [ << Hide Help ] [ Tool Help

6. Run Data Management > Raster > Raster Properties - Build Raster Attribute Table with the
overwrite option selected on the 8-bit indicator raster.

7. Finally, run Data Management - Raster - Raster Properties = Build Pyramids on the indicator
raster.

8. To generate a mask for use in modifying density and morphology outputs, use the NLCD 2006
impervious surface raster and re-classify it into a mask of NLCD ‘data’ areas (0) vs nodata (1)
using Spatial Analyst Tools > Map Algebra - Raster Calculator:
Con("Landcover_NLCD2006.tif",0,1, "VALUE<127")

& Raster Calculator

Map Algebra expression

L Conditional
R WeEE) =
()] (el

Math
ol i) [ldpdl) 2. -

Abs
Con{"Landcover_Impervious_MLCD2006.",0,1, "VALUE<127")

] »

Qutput raster
D:\Workspace\Scratch\nlcddatamask, tif @

OK ] [ Cancel ] [Environmems... ] [ << Hide Help
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Calculate Density Values
The ArcGIS Focal Statistics tool and Conditional tool (Con) are used to generate density rasters for each
moving window size. See Appendix 2 for window size details.

Three types of density values are calculated: raw density percentages (Pf), scaled byte values (Sf), and
categorized scaled densities. These values are generated using a combination of focal (neighborhood)
sums and counts.

Pfy = adjusted focal sum for cover type x where y = window size
focal count for cover type x

For each focal landscape area (i.e. moving window), a focal count of candidate pixels is generated from
the indicator raster. This value accounts for the proportional occurrence of target cover type pixels within
the landscape area. In other words, it adjusts for NoData areas and minimizes edge effects from the
target cover type. The adjusted focal sum is calculated from the binary cover type raster.

Sfy = Int((Pfy * 254) + 1) where y = window size
The scaled byte values for landscape area y are calculated by adjusting the raw density values (Pf) to a
1-255 scale. This does result in a loss of precision, but this was deemed acceptable given the relative

coarseness of the source landcover data.

The categorized scaled densities are generated by reclassifying the scaled byte values into grouped
density classes. See Appendix 2 for reclassification details.

Using Raster Calculator to generate Pf, Sf, and categorized scaled density values

Note: Source_Raster is the cover type indicator raster discussed above.

Adjusted focal sum for cover type x and window size y:

Float (FocalStatistics (Con (Raster (Source Raster), 1, 0, "VALUE = 2"),

NbrRectangle (str(y), str(y), "CELL"), "SUM"))
"rx\\‘ Raster Calculator = = P3
Map Algebra expression il
Conditional

m| w

noonEnnk
(el ](e]) o e | =

Elelle)a]] r
(S 9 [ -

Float{FocalStatistics{Con(Raster(Source_Raster), 1, 0, "WALUE = 27), NbrRectangle(str{y), str{y), "CELL"), "SUM™))

Quiput raster
D:'WMiscellanecus\adjFocalSum -

oK ] [ Cancel ] [Environments... ] [ Show Help == ]
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Focal count for cover type x and window size y:

Float (FocalStatistics (Con (Raster (Source Raster), 1, 0, "VALUE > 0"),
NbrRectangle (str(y), str(y), "CELL"), "SUM"))

P

K\ Raster Calculater | = = % |

Map Algebra expression

Conditional

[E2) 0 [0 75 9 9

Setiull
Math
Abs

o] [l 22, -

Float{Focalstatistics{Con(Raster(Source_Raster), 1, 0, "WALUE = 07), NbrRectangle(str(y), str{y), "CELL™), "SUM™))

mE

Dutput raster
D:\Miscellaneous\adiFocaCount @ il

[ CK ” Cancel ”Emrironments... ” Show Help == ]

Combining two steps above to produce raw density percentage for cover type x and window size y (Pfx):

Float (FocalStatistics (Con (Raster (Source Raster), 1, 0, "VALUE = 2"),
NbrRectangle (str(y), str(y), "CELL"), "SUM")) /

Float (FocalStatistics (Con (Raster (Source Raster), 1, 0, "VALUE > 0"),
NbrRectangle (str(y), str(y), "CELL"), "SUM"))

3 | al

#, Raster Calculator | = | =\ 3

Map Algebra expression

Conditicnal

EA[EN ER IR (8| vt

(2 )l o) ][]l )] e

(o] (] =
Math

BRI R e

0 | | O 0 -

Float{Focalstatistics(Con(Raster(Source_Raster), 1, 0, "ALUE = 27), MbrRectangle(str(y), stry), "CELL™), "sUM7) [
Float{FocalStatistics{Con{Raster(Source_Raster), 1, 0, "VALUE = 07), MbrRectangle(str{y), str(y), "CELL™), SUM™))

[ »

Output raster
D:'\MiscellaneousirawDensity @ i

[ Ok ] [ Cancel ”En!.rironments... ][ Show Help = ]
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Scaled byte values for cover type x and window size y (Sfx):

Int (Pfx raster * 254) + 1

Date: January 6, 2014

‘:\ Raster Calculator = B £
Map Algebra expression il
Conditional s
DD BNEE D
2] )l
(i) (el ==
Math
] on
Lo b 2. -
Int{rawDensity = 254) + 1
Qutput raster
D:'\WMiscellaneousrawDenScaled @ i
[ QK ] [ Cancel ] [Environments... ] [ Show Help == ]
Categorized scaled density for cover type x and window size y:
ReclassByTable (Sfx raster, Reclass Table, "FROM VAL", "TO VAL", "OUT VAL", "NODATA")
* Reclass by Table Lo | e
-
anput raster
D:\MiscellaneousrawDenScaled @
Input remap table
IPatternDensity_Reclass LI @
From value field
FROM_VAL -
To value field
TO_VAL -
Output value field
OUT_VAL -
Output raster
D:\WMiscellaneous\densityCats @
Change missing values to NoData (optional)
[ 0K ] [ Cancel ] [Em-'irnnments... ] [ Show Help == ]
%

See the Density Category and Grouped Category Reclassification Table in Appendix 2 for re-

classification values.
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